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[bookmark: _Toc392005452]BACKGROUND
A.	The United States of America (“United States”), on behalf of the Administrator of the U.S. Environmental Protection Agency (EPA), filed a complaint in this matter pursuant to [insert causes of action and relief sought, e.g.: Sections 106 and 107 of the Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), 42 U.S.C. §§ 9606 and 9607, seeking injunctive relief regarding the cleanup of the [insert site name] in [insert City, County, State] (“Site”), and recovery of costs incurred and to be incurred in responding to the release or threat of release of hazardous substances at or in connection with the Site.]
B.	As a result of the release or threatened release of hazardous substances, EPA has undertaken response actions at or in connection with the Site under Section 104 of CERCLA, 42 U.S.C. § 9604, and will undertake response actions in the future. In performing these response actions, EPA has incurred and will continue to incur response costs at or in connection with the Site. [NOTE: Insert brief description of response actions undertaken at the Site to date by EPA or other persons. Describe briefly any previous settlements for performance of work or recovery of costs.]
C.	 EPA has determined the following:
1.	prompt settlement with each Settling Defendant [if Settling Federal Agencies (SFAs) insert: and each Settling Federal Agency] is practicable and in the public interest within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1);
2.	the payment to be made by each Settling Defendant [and each Settling Federal Agency] under this Consent Decree involves only a minor portion of the response costs at the Site within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1), based upon EPA’s estimate that the total response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund and by other persons is [insert either: “$______” or “between $______ and $______”] [NOTE: The dollar figure inserted in this Paragraph should include the total response costs incurred to date as well as the Agency’s projection of the total response costs to be incurred during completion of the remedial action at the Site. The response costs total should include costs of the United States and any other person at the Site.]; and
3.	the amount of hazardous substances contributed to the Site by each Settling Defendant [and each Settling Federal Agency] and the toxic or other hazardous effects of the hazardous substances contributed to the Site by each Settling Defendant [and each Settling Federal Agency] are minimal in comparison to other hazardous substances at the Site within the meaning of Section 122(g)(1)(A) of CERCLA, 42 U.S.C. § 9622(g)(1)(A). This is because [insert volume and toxicity criteria used to qualify as a de minimis party under this Consent Decree, e.g.: the amount of hazardous substances contributed to the Site by each Settling Defendant [and each Settling Federal Agency] does not exceed [insert either: “___% of the hazardous substances at the Site,” or “___ pounds/gallons of materials containing hazardous substances,”] and the hazardous substances contributed by each Settling Defendant [and each Settling Federal Agency] to the Site are not significantly more toxic or of significantly greater hazardous effect than other hazardous substances at the Site.] [NOTE: Where practicable, an attachment listing the volume and general nature of the hazardous substances contributed to the Site by each Settling Defendant (and each SFA, if any), to the extent available, may be included as an appendix. The total estimated volume of hazardous substances at the Site should be noted on the attachment, if one is used.]
D.	Settling Defendants do not admit any liability to Plaintiff arising out of the transactions or occurrences alleged in the complaint. [Settling Federal Agencies do not admit any liability arising out of the transactions or occurrences alleged in any counterclaim asserted by Settling Defendants.]
E.	The United States and Settling Defendants [and Settling Federal Agencies] agree, and this Court by entering this Consent Decree finds, that this Consent Decree has been negotiated by the Parties in good faith, that settlement of this matter without further litigation and without the [any further] admission or adjudication of any issue of fact or law is appropriate and will avoid prolonged and complicated litigation between the Parties, and that this Consent Decree is fair, reasonable, and in the public interest.
	THEREFORE, with the consent of the Parties to this Decree, it is ORDERED, ADJUDGED, AND DECREED:
[bookmark: _Toc392005453]JURISDICTION
This Court has jurisdiction over the subject matter of this action pursuant to 28 U.S.C. §§ 1331 and 1345 and 42 U.S.C. § 9613(b), and also has personal jurisdiction over Settling Defendants. Settling Defendants consent to and shall not challenge the terms of this Consent Decree or this Court’s jurisdiction to enter and enforce this Consent Decree.
[bookmark: _Toc392005454]PARTIES BOUND
This Consent Decree is binding upon the United States and upon Settling Defendants and their [heirs,] successors, and assigns. Any change in ownership or corporate or other legal status of a Settling Defendant, including but not limited to, any transfer of assets or real or personal property shall in no way alter such Settling Defendant’s responsibilities under this Consent Decree.
[bookmark: _Toc392005455]DEFINITIONS
Unless otherwise expressly provided in this Consent Decree, terms used in this Consent Decree that are defined in CERCLA or in regulations promulgated under CERCLA shall have the meanings assigned to them in CERCLA or its regulations. Whenever the terms listed below are used in this Consent Decree or its appendices, the following definitions shall apply:
“CERCLA” shall mean the Comprehensive Environmental Response, Compensation, and Liability Act, 42 U.S.C. §§ 9601-9675. 
“Consent Decree” or “Decree” shall mean this Consent Decree and all appendices attached hereto. In the event of conflict between this Consent Decree and any appendix, the Consent Decree shall control.
“Day” or “day” shall mean a calendar day. In computing any period of time under this Consent Decree, where the last day would fall on a Saturday, Sunday, or federal or State holiday, the period shall run until the close of business of the next working day.
“DOJ” shall mean the U.S. Department of Justice and its successor departments, agencies, or instrumentalities.
“Effective Date” shall mean the date upon which the approval of this Consent Decree is recorded on the Court’s docket.
“EPA” shall mean the U.S. Environmental Protection Agency and its successor departments, agencies, or instrumentalities.
“EPA Hazardous Substance Superfund” shall mean the Hazardous Substance Superfund established by the Internal Revenue Code, 26 U.S.C. § 9507.
“Interest” shall mean interest at the rate specified for interest on investments of the EPA Hazardous Substance Superfund established by 26 U.S.C. § 9507, compounded annually on October 1 of each year, in accordance with 42 U.S.C. § 9607(a). The applicable rate of interest shall be the rate in effect at the time the interest accrues. The rate of interest is subject to change on October 1 of each year. Rates are available online at https://www.epa.gov/superfund/superfund-interest-rates.
“National Contingency Plan” or “NCP” shall mean the National Oil and Hazardous Substances Pollution Contingency Plan promulgated pursuant to Section 105 of CERCLA, 42 U.S.C. § 9605, codified at 40 C.F.R. Part 300, and any amendments thereto.
“Paragraph” shall mean a portion of this Consent Decree identified by an Arabic numeral or an upper or lower case letter.
“Parties” shall mean the United States and the Settling Defendants.
“RCRA” shall mean the Solid Waste Disposal Act, 42 U.S.C. §§ 6901-6992 (also known as the Resource Conservation and Recovery Act).
“Section” shall mean a portion of this Consent Decree identified by a Roman numeral.
“Settling Defendants” shall mean those persons, corporations, or other entities listed in Appendix A. [NOTE: Instead of listing the name of each Settling Defendant in Appendix A and the amount of payment by each Settling Defendant in Appendix C, Regions may choose to create one Appendix to serve both purposes.]
[NOTE: If SFAs, insert the following definition.]
[“Settling Federal Agencies” shall mean [insert names of specific federal entities whose liability is being resolved to make clear that only those entities and each of their direct successors is included] and their successor departments, agencies, or instrumentalities.][footnoteRef:1] [1:  If the Region has any information suggesting federal agency liability, such information should be provided to DOJ as soon as possible. For information regarding CERCLA § 104(e) information requests to federal agencies, review the “Guidance on Issuing CERCLA Section 104(e)(2) Information Requests to Federal Agencies at Privately-owned Superfund Sites” (June 14, 2004), available at https://www.epa.gov/enforcement/guidance-issuing-superfund-104e2-information-requests-federal-agencies-privately-owned.] 

“Site” shall mean the ______ Superfund Site, encompassing approximately ___ acres, located at [insert address or description of location] in [insert City, County, State] and [insert either: “generally shown on the map attached as Appendix B” or “generally designated by the following property description: ______”]
“State” shall mean the State [or Commonwealth] of ______.
“[Site name] Special Account” shall mean the special account, within the EPA Hazardous Substance Superfund, established for the Site by EPA pursuant to Section 122(b)(3) of CERCLA, 42 U.S.C. § 9622(b)(3), and [if applicable, identify prior settlement under which EPA established the special account].
“United States” shall mean the United States of America, and each department, agency, and instrumentality of the United States, including EPA [and Settling Federal Agencies].
[bookmark: _Toc392005456]STATEMENT OF PURPOSE
[NOTE: As drafted, this Statement of Purpose assumes that all Settling Defendants (and SFAs, if any) are making a cash payment, which includes a premium amount, in exchange for a full and final settlement with the United States for all civil liability under CERCLA §§ 106 and 107 with respect to the Site as a whole. This Statement of Purpose will need to be amended if the settlement is of narrower scope with respect to some or all Settling Defendants (or SFAs) because, e.g., it relates to only one operable unit, or it includes a reservation of rights for cost overruns. When using this or any other Statement of Purpose, be sure that it is consistent with the Covenants by United States, the Reservations of Rights by United States, and the definition of “matters addressed” in Paragraph 22.]
By entering into this Consent Decree, the mutual objectives of the Parties are:
to reach a final settlement among the Parties with respect to the Site pursuant to Section 122(g) of CERCLA, 42 U.S.C. § 9622(g), that allows Settling Defendants [and Settling Federal Agencies] to make a cash payment, including a premium, to resolve their alleged civil liability under Sections 106 and 107 of CERCLA, 42 U.S.C. §§ 9606 and 9607, for injunctive relief with regard to the Site and for response costs incurred and to be incurred at or in connection with the Site, thereby reducing litigation relating to the Site;
to simplify any remaining administrative and judicial enforcement activities concerning the Site by eliminating a [substantial] number of potentially responsible parties from further involvement at the Site; and
to obtain settlement with Settling Defendants [and Settling Federal Agencies] for their fair share of response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, and by other persons, and to provide for full and complete contribution protection for Settling Defendants [and Settling Federal Agencies] with regard to the Site pursuant to Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 9622(g)(5), or as otherwise may be provided by law.
[bookmark: _Ref307225407][bookmark: _Ref307225476][bookmark: _Ref307225518][bookmark: _Toc392005457]PAYMENT
[bookmark: _Ref307226333][bookmark: _Ref295487120][bookmark: _Ref290297920]Within 30 days after the Effective Date, each Settling Defendant shall pay to EPA [insert either: “the amount set forth below” or “the amount set forth in Appendix C to this Consent Decree”]. 
[bookmark: _Ref306189600][bookmark: _Ref307226323]Each Settling Defendant’s payment includes an amount for: (a) past response costs incurred at or in connection with the Site; (b) projected future response costs to be incurred at or in connection with the Site; and [insert, if a premium is included in the payment: (c) a premium to cover the risks and uncertainties avoided by participation in this settlement, including but not limited to, the risk that total response costs incurred or to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, or by any other person, will exceed the estimated total response costs upon which Settling Defendants’ payments are based.] 
[NOTE: If some Settling Defendants are paying a premium and some are not, Paragraph 6 will need to be redrafted to indicate that there are both premium and non-premium Settling Defendants.].
[bookmark: _Ref306189641]Each Settling Defendant shall make payment at [NOTE: choose one method after consulting with Settling Defendants: [at https://www.pay.gov] [by Fedwire Electronic Funds Transfer (EFT)]] to the U.S. Department of Justice account, in accordance with instructions provided to Settling Defendants by the Financial Litigation Unit (FLU) of the U.S. Attorney’s Office for the District of ______ after the Effective Date. The payment instructions provided by the FLU will include a Consolidated Debt Collection System (CDCS) number, which shall be used to identify all payments required to be made in accordance with this Consent Decree. The FLU will provide the payment instructions to:
[Insert name, address, phone number, and email address of the individual who will be responsible for making the payment (if Settling Defendants are numerous, refer to attached Appendix)]
on behalf of each Settling Defendant. A Settling Defendant may change the individual to receive payment instructions on its behalf by providing written notice of such change to EPA by [email or] regular mail and to DOJ by email or regular mail at:
[EPA by email:		[                ]]

EPA:				[Name]
				EPA Project Coordinator
				U.S. Environmental Protection Agency
				Region __
				[Address]

DOJ by email:		eescasemanagement.enrd@usdoj.gov

DOJ by regular mail:	EES Case Management Unit
				U.S. Department of Justice
				Environment and Natural Resources Division
				P.O. Box 7611
				Washington, D.C. 20044-7611
[NOTE: Payment by check is highly discouraged. If necessary, contact DOJ’s Environmental Enforcement Section to obtain current instructions for payment by check.] 
[NOTE ABOUT SPECIAL ACCOUNTS: The Decree should specify whether payments made under Paragraph 5 should be deposited in the EPA Hazardous Substance Superfund, or in a site-specific special account within the EPA Hazardous Substance Superfund, or should be split between the Superfund and the Special Account (and should specify the split).]
Deposit of Payment. [Insert one of the following three sentences here.] [The total amount to be paid pursuant to Paragraph 5 shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid pursuant to Paragraph 5 shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid pursuant to Paragraph 5, [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.]
Notice of Payment. At the time of payment, each Settling Defendant shall send notice that such payment has been made to: (a) the EPA Cincinnati Finance Center (CFC) by email or regular email; [Region may include: (b) EPA by email or regular mail;] and (c) DOJ by email or regular mail at:
EPA CFC by email:		cinwd_acctsreceivable@epa.gov

EPA CFC by regular mail:	EPA Cincinnati Finance Office
				26 W. Martin Luther King Drive
				Cincinnati, Ohio 45268

[EPA by regular mail: 	EPA Project Coordinator
				U.S. Environmental Protection Agency
				Region __
				[Address]]

DOJ by email:		eescasemanagement.enrd@usdoj.gov
				Re: DJ # ______

DOJ by regular mail:	EES Case Management Unit
				U.S. Department of Justice
				Environment and Natural Resources Division
				P.O. Box 7611
				Washington, D.C. 20044-7611
Each such notice shall reference the CDCS Number, Site/Spill ID Number ______, and DJ Number ______.
[NOTE ON REQUIRING ONE COLLECTIVE PAYMENT: If the settlement involves a large number of Settling Defendants, it may be appropriate to include alternative instructions under which Settling Defendants are to establish a short-term trust or escrow account to receive their individual payments and to make one collective payment to the Superfund, using one of the payment approaches noted in Paragraph 7. In such event, the cost of the trust or escrow account may be funded from interest earned by the account or through other appropriate means.]
[NOTE: The following paragraph may be added if Settling Defendants will be making payment to a potentially responsible party (PRP)-managed trust fund or escrow account established pursuant to an existing settlement with EPA. If this paragraph is used, add definitions for “Performing Parties” and “Performing Parties’ Response Costs.”]
[Payment to Performing Parties. Within 30 days after the Effective Date, each Settling Defendant shall pay to Performing Parties $______, in payment of Performing Parties’ Response Costs. Payment shall be made to [insert instructions].]
[If SFAs are making payments, insert the following paragraph.]
[bookmark: _Ref299522678][Payments by Settling Federal Agencies. As soon as reasonably practicable after the Effective Date, the United States, on behalf of each Settling Federal Agency, shall:
[bookmark: _Ref307226395]Payment to EPA.
[bookmark: _Ref299522666][bookmark: _Ref307226389]Pay to EPA [insert either: “the amount set forth below” or “the amount set forth in Appendix __ to this Consent Decree”]. Each Settling Federal Agency’s payment includes an amount for: (1) past response costs incurred at or in connection with the Site; (2) projected future response costs to be incurred at or in connection with the Site; and [insert, if a premium is included in the payment: (3) a premium to cover the risks and uncertainties avoided by participation in this settlement, including but not limited to, the risk that total response costs incurred or to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, or by any other person, will exceed the estimated total response costs upon which Settling Federal Agencies’ payments are based.] [NOTE: If some SFAs are paying a premium and some are not, this Paragraph will need to be redrafted to indicate that there are both premium and non-premium SFAs.].
Deposit of SFA Payment. [Insert one of the following three sentences.] [The total amount to be paid on behalf of Settling Federal Agencies pursuant to this Paragraph shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid on behalf of Settling Federal Agencies pursuant to this Paragraph shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid on behalf of Settling Federal Agencies pursuant to this Paragraph, [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.].
[NOTE: If SFAs will be making payment to a PRP-managed trust fund or escrow account established pursuant to an existing settlement with EPA, add the following paragraph. Also add definitions for “Performing Parties” and “Performing Parties’ Response Costs.”]
[bookmark: _Ref376790668][Payment to Performing Parties. Pay to Performing Parties $______, in payment of Performing Parties’ Response Costs, by Automated Clearinghouse (ACH) Electronic Funds Transfer in accordance with instructions provided by Performing Parties.]
[bookmark: _Ref299522731]Interest. In the event that payment[s] required by Paragraph 11.a(1) [or Paragraph 11.b] is [are] not made within 120 days after the Effective Date, the United States, on behalf of each Settling Federal Agency, shall pay Interest on the unpaid balance, with such interest commencing on the 121st day after the Effective Date and accruing through the date of the payment.
[bookmark: _Toc392005458]FAILURE TO MAKE PAYMENT
[bookmark: _Ref307226227]If any Settling Defendant fails to make full payment within the time required by Paragraph 5, that Settling Defendant shall pay Interest on the unpaid balance, which shall accrue from the Effective Date until the date of payment. In addition, if any Settling Defendant fails to make full payment as required by Paragraph 5, the United States may, in addition to any other available remedies or sanctions, bring an action against that Settling Defendant seeking injunctive relief to compel payment and/or seeking civil penalties under Section 122(l) of CERCLA, 42 U.S.C. § 9622(l), for failure to make timely payment.
[bookmark: _Ref307226120][bookmark: _Toc392005459]COVENANTS BY UNITED STATES
[bookmark: _Ref307211754]Covenants for Settling Defendants. Except as specifically provided in Section IX (Reservations of Rights by United States), the United States[footnoteRef:2] covenants not to sue or take administrative action against any of the Settling Defendants pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of RCRA, 42 U.S.C. § 6973,][footnoteRef:3] relating to the Site. With respect to present and future liability, these covenants shall take effect for each Settling Defendant upon the Effective Date. With respect to each Settling Defendant, individually, these covenants are conditioned upon: (a) the satisfactory performance by Settling Defendant of all obligations under this Consent Decree; and (b) the veracity and completeness of the information provided to EPA by Settling Defendant relating to Settling Defendant’s involvement with the Site. These covenants extend only to Settling Defendants and do not extend to any other person.  [2:  If any agency other than EPA or DOJ, such as Coast Guard or Federal Emergency Management Agency, has or may incur response costs at the Site, such costs must either be addressed in the settlement or must be explicitly reserved in Paragraph 15. ]  [3:  If including a RCRA § 7003 covenant in Paragraph 13 (and 14, if SFAs), pursuant to Section 7003(d) of RCRA, you must offer to have a public meeting regarding the settlement and hold such a meeting if requested. To do this, include language in the Federal Register notice providing for an opportunity for a public meeting in the affected area. For guidance regarding how to comply with this requirement, see “Revised Model Notice Language for Compliance with Public Participation Requirements of Section 7003(d) of RCRA” (Oct. 30, 1996), available at https://www.epa.gov/enforcement/guidance-model-language-compliance-public-participation-requirements-under-rcra-section.] 

[If SFA, add next paragraph.]
[bookmark: _Ref307211766][bookmark: _Ref307212489][Covenants for Settling Federal Agencies. Except as specifically provided in Section IX (Reservations of Rights by United States), EPA covenants not to take administrative action against any of the Settling Federal Agencies pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of RCRA, 42 U.S.C. § 6973,] relating to the Site. With respect to present and future liability, these covenants shall take effect for each Settling Federal Agency upon the Effective Date. With respect to each Settling Federal Agency, individually, these covenants are conditioned upon: (a) the satisfactory performance by Settling Federal Agency of all obligations under this Consent Decree; and (b) the veracity and completeness of the information provided to EPA by Settling Federal Agency relating to Settling Federal Agency’s involvement with the Site. These covenants extend only to Settling Federal Agencies and do not extend to any other person.] 
[bookmark: _Ref307212662][bookmark: _Toc392005460][bookmark: _Ref290297688]RESERVATIONS OF RIGHTS BY UNITED STATES
[bookmark: _Ref307211738] The United States reserves, and this Consent Decree is without prejudice to, all rights against Settling Defendants [if SFAs, insert: and EPA and the federal natural resource trustees reserve, and this Consent Decree is without prejudice to, all rights against Settling Federal Agencies,] with respect to all matters not expressly included within Section VIII (Covenants by United States). Notwithstanding any other provision of this Consent Decree, the United States reserves all rights against Setting Defendants [and EPA and the federal natural resource trustees reserve, and this Consent Decree is without prejudice to, all rights against Settling Federal Agencies,] with respect to: 
[bookmark: _Ref290298401]liability for failure to meet a requirement of this Consent Decree;
[bookmark: _Ref290298412]criminal liability;
liability for damages for injury to, destruction of, or loss of natural resources, and for the costs of any natural resource damage assessments;[footnoteRef:4]  [4:  This natural resource damages reservation must be included unless the federal natural resource trustee(s) has/have agreed to a covenant not to sue pursuant to Section 122(j)(2) of CERCLA. In accordance with Section 122(j)(1) of CERCLA, where the release or threatened release of any hazardous substance at the Site may have resulted in damages to natural resources under the trusteeship of the United States, the Region should notify the federal natural resource trustee(s) of the negotiations and encourage the trustee(s) to participate in the negotiations.] 

[bookmark: _Ref306189436]liability based on the ownership or operation of the Site by Settling Defendants [or Settling Federal Agencies]; or
liability based on Settling Defendants’ [or Settling Federal Agencies’] transportation, treatment, storage, or disposal, or arrangement for transportation, treatment, storage, or disposal, of a hazardous substance or a solid waste at or in connection with the Site, after signature of this Consent Decree by Settling Defendants [or Settling Federal Agencies].
[bookmark: _Ref299523196]Notwithstanding any other provision in this Consent Decree, the United States reserves, and this Consent Decree is without prejudice to, the right to institute proceedings against any individual Settling Defendant in this action or in a new action or to issue an administrative order to any individual Settling Defendant seeking to compel that Settling Defendant [if SFAs, insert: , and EPA reserves, and this Consent Decree is without prejudice to, the right to issue an administrative order to any individual Settling Federal Agency,] to perform response actions relating to the Site, and/or to reimburse the United States for additional costs of response, if: 
information is discovered that indicates that such Settling Defendant [or such Settling Federal Agency] contributed hazardous substances to the Site in such greater amount or of such greater toxic or other hazardous effects that such Settling Defendant [or such Settling Federal Agency] no longer qualifies as a de minimis party at the Site because [insert volume and toxicity criteria from Section I, Paragraph C.3, e.g.: Settling Defendant [or Settling Federal Agency] contributed greater than ___% of the hazardous substances at the Site, or contributed hazardous substances that are significantly more toxic or are of significantly greater hazardous effect than other hazardous substances at the Site]; or
[NOTE: The cost overrun reopener in Paragraph 16.b should only be included with respect to any Settling Defendant (or any SFA) who is not paying a premium in lieu of this reopener.]
[bookmark: _Ref307226559][total response costs incurred or to be incurred at or in connection with the Site by the United States or any other person exceed $______ [insert total response costs estimate upon which Settling Defendants’ (and SFAs’) payments are based]. [NOTE: If some Settling Defendants (or SFAs) are paying a premium in lieu of the cost overrun reopener and some are not, insert: This Paragraph shall not apply to those Settling Defendants [and those Settling Federal Agencies] identified [insert: “in Paragraph ___” or “in Appendix ___”] who have elected to pay a premium amount pursuant to Paragraphs 5 and 6 [if SFAs, insert: (for Settling Defendants), or Paragraph 11.a(1) (for Settling Federal Agencies)].
[bookmark: _Ref312074526][bookmark: _Toc392005461]COVENANTS BY SETTLING DEFENDANTS [AND SETTLING FEDERAL AGENCIES]
[bookmark: _Ref307212511]Covenants by Settling Defendants. 
Settling Defendants covenant not to sue and agree not to assert any claims or causes of action against the United States or its contractors or employees with respect to the Site[footnoteRef:5] and this Consent Decree, including, but not limited to:  [5:  The covenants by the United States, Paragraph 13 (and 14, if applicable), are drafted to resolve fully Settling Defendants’ (and SFAs’) liability for the Site as a whole. However, if this is not the case, the scope of Paragraph 17 (and 18) may be narrowed to conform to the scope of the United States’ covenants.] 

any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund based on Sections 106(b)(2), 107, 111, 112, or 113 of CERCLA, 42 U.S.C. §§ 9606(b)(2), 9607, 9611, 9612, or 9613, or any other provision of law;
any claims arising out of response actions at or in connection with the Site, including any claim under the United States Constitution, the Constitution of the State [Commonwealth] of ______, the Tucker Act, 28 U.S.C. § 1491, the Equal Access to Justice Act, 28 U.S.C. § 2412, or at common law; and
any claim pursuant to Sections 107 and 113 of CERCLA, 42 U.S.C. §§ 9607 and 9613, RCRA Section 7002(a), 42 U.S.C. § 6972(a), or state law regarding the Site.
Except as provided in Paragraph 20 (waiver of claims) and Paragraph 25 (waiver of claim-splitting defenses), these covenants shall not apply in the event the United States brings a cause of action or issues an order pursuant to any of the reservations set forth in Section IX (Reservations of Rights by United States), other than in Paragraph 15.a (liability for failure to meet a requirement of the Consent Decree) or 15.b (criminal liability), but only to the extent that Settling Defendants’ claims arise from the same response action, response costs, or damages that the United States is seeking pursuant to the applicable reservation.
[bookmark: _Ref290299826][If SFAs, insert: Covenant by Settling Federal Agencies. Settling Federal Agencies agree not to assert any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund through CERCLA §§ 106(b)(2), 107, 111, 112, 113 or any other provision of law with respect to the Site and this Consent Decree. This covenant does not preclude demand for reimbursement from the Superfund of costs incurred by a Settling Federal Agency in the performance of its duties (other than pursuant to this Consent Decree) as lead or support agency under the NCP.]
Nothing in this Consent Decree shall be deemed to constitute approval or preauthorization of a claim within the meaning of Section 111 of CERCLA, 42 U.S.C. § 9611, or 40 C.F.R. § 300.700(d).
[bookmark: _Ref307212638]Settling Defendants agree not to assert any claims and to waive all claims or causes of action (including but not limited to claims or causes of action under Section 107(a) or 113 of CERCLA) that they may have for response costs [if natural resource damage claims are being resolved through this settlement, insert: and for natural resource damages and assessment costs] relating to the Site against each other or any other person who is a potentially responsible party under CERCLA at the Site. This waiver shall not apply with respect to any defense, claim, or cause of action that a Settling Defendant may have against any person if such person asserts a claim or cause of action relating to the Site against such Settling Defendant. [NOTE: If a Settling Defendant asserts that it has a claim against a PRP within the scope of this waiver that is unrelated to the PRP’s CERCLA liability at the Site, e.g., a claim for contractual indemnification, add an exception for such claim such as the following: This waiver also shall not apply to Settling Defendant’s contractual indemnification claim against [insert name].]
[bookmark: _Toc392005462]EFFECT OF SETTLEMENT/CONTRIBUTION
Except as provided in Paragraph 20 (waiver of claims), nothing in this Consent Decree shall be construed to create any rights in, or grant any cause of action to, any person not a Party to this Consent Decree. Except as provided in Section X (Covenants by Settling Defendants [and Settling Federal Agencies]), each of the Parties expressly reserves any and all rights (including, but not limited to, pursuant to Section 113 of CERCLA, 42 U.S.C. § 9613), defenses, claims, demands, and causes of action that each Party may have with respect to any matter, transaction, or occurrence relating in any way to the Site against any person not a Party hereto. Nothing in this Consent Decree diminishes the right of the United States, pursuant to Section 113(f)(2) and (3) of CERCLA, 42 U.S.C. § 9613(f)(2)-(3), to pursue any such persons to obtain additional response costs or response action and to enter into settlements that give rise to contribution protection pursuant to Section 113(f)(2).
[bookmark: _Ref307226306]The Parties agree, and by entering this Consent Decree this Court finds, that this Consent Decree constitutes a judicially-approved settlement pursuant to which each Settling Defendant [and each Settling Federal Agency] has, as of the Effective Date, resolved liability to the United States within the meaning of Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 122(g)(5), and is entitled, as of the Effective Date, to protection from contribution actions or claims as provided by Sections 113(f)(2) and 122(g)(5) of CERCLA, or as may be otherwise provided by law, for the “matters addressed” in this Consent Decree. The “matters addressed” in this Consent Decree are [all response actions taken or to be taken and all response costs incurred or to be incurred, at or in connection with the Site, by the United States or any other person],[footnoteRef:6] except for the State;[footnoteRef:7] provided, however, that if the United States exercises rights under the reservations in Section IX (Reservations of Rights by United States), other than in Paragraph 15.a (liability for failure to meet a requirement of the Consent Decree) or 15.b (criminal liability), the “matters addressed” in this Consent Decree will no longer include those response costs or response actions [if the Decree includes a natural resource damages settlement include: or natural resource damages] that are within the scope of the exercised reservation. [6:  This definition of “matters addressed” assumes that this Consent Decree is designed to resolve fully Settling Defendants’ (and SFAs’, if any) liability at the Site. If the intended resolution of liability is narrower in scope, then the definition of “matters addressed” will need to be narrowed.]  [7:  If the State is a party and is resolving its claims regarding the Site through this settlement, delete “except for the State.” Note that State claims do not include claims for EPA Hazardous Substance Superfund costs that have been provided to the State through a cooperative agreement with EPA and for which EPA retains the responsibility for cost recovery.] 

The Parties further agree, and by entering this Consent Decree this Court finds, that the complaint filed by the United States in this action is a civil action within the meaning of Section 113(f)(1) of CERCLA, 42 U.S.C. § 9613(f)(1), and that this Consent Decree constitutes a judicially-approved settlement pursuant to which each Settling Defendant [if SFAs insert: and each Settling Federal Agency] has, as of the Effective Date, resolved liability to the United States within the meaning of Section 113(f)(3)(B) of CERCLA, 42 U.S.C. § 9613(f)(3)(B).
Each Settling Defendant shall, with respect to any suit or claim brought by it for matters related to this Consent Decree, notify EPA and DOJ in writing no later than 60 days prior to the initiation of such suit or claim. Each Settling Defendant shall, with respect to any suit or claim brought against it for matters related to this Consent Decree, notify EPA and DOJ in writing within 10 days after service of the complaint or claim upon such Settling Defendant. In addition, each Settling Defendant shall notify EPA and DOJ within 10 days after service or receipt of any Motion for Summary Judgment and within 10 days after receipt of any order from a court setting a case for trial, for matters related to this Consent Decree.
[bookmark: _Ref307226652]In any subsequent administrative or judicial proceeding initiated by the United States for injunctive relief, recovery of response costs, or other relief relating to the Site, Settling Defendants shall not assert, and may not maintain, any defense or claim based upon the principles of waiver, res judicata, collateral estoppel, issue preclusion, claim-splitting, or other defenses based upon any contention that the claims raised in the subsequent proceeding were or should have been brought in the instant action; provided, however, that nothing in this Paragraph affects the enforceability of the covenants set forth in Section VIII (Covenants by United States).
[bookmark: _Toc392005463]CERTIFICATION OF SETTLING DEFENDANTS [AND SETTLING FEDERAL AGENCIES]
By signing this Consent Decree, each Settling Defendant certifies, individually, that, to the best of its knowledge and belief, it:
has conducted a thorough, comprehensive, good faith search for documents, and has fully and accurately disclosed to EPA, all information currently in its possession, or in the possession of its officers, directors, employees, contractors, or agents, that relates in any way to the ownership, operation, or control of the Site, or to the ownership, possession, generation, treatment, transportation, storage, or disposal of a hazardous substance, pollutant, or contaminant at or in connection with the Site; 
has not altered, mutilated, discarded, destroyed, or otherwise disposed of any records, reports, documents, or other information (including records, reports, documents, or other information in electronic form) (other than identical copies) relating to its potential liability regarding the Site since notification of potential liability by the United States or the State; and
has and will comply fully with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e), 122(e)(3)(B), and 122(g)(8) of CERCLA, 42 U.S.C. §§ 9604(e), 9622(e)(3)(B), and 9622(g)(8), Section 3007 of RCRA, 42 U.S.C. § 6927, and state law.
[If SFAs, insert: “The United States acknowledges that each Settling Federal Agency (1) is subject to all applicable Federal record retention laws, regulations, and policies; and (2) has certified that it has fully complied with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e), 122(e)(3)(B), and 122(g)(8) of CERCLA, 42 U.S.C. §§ 9604(e), 9622(e)(3)(B), and 9622(g)(8), and Section 3007 of RCRA, 42 U.S.C. § 6927, and state law.”[footnoteRef:8]] [8:  EPA attorneys must assure that the Agency has received a written response to any information requests that it has sent to Settling Federal Agencies containing a certification substantially similar to that required from private PRPs.] 

[bookmark: _Toc392005464]RETENTION OF JURISDICTION
[bookmark: _Ref290300098]This Court shall retain jurisdiction over this matter for the purpose of interpreting and enforcing the terms of this Consent Decree.
[bookmark: _Toc392005465]INTEGRATION/APPENDICES
This Consent Decree and its appendices constitute the final, complete, and exclusive agreement and understanding among the Parties with respect to the settlement embodied in this Consent Decree. The Parties acknowledge that there are no representations, agreements, or understandings relating to the settlement other than those expressly contained in this Consent Decree. The following appendices are attached and incorporated into this Consent Decree:
“Appendix A” is [the list of Settling Defendants].
“Appendix B” is [the map of the Site].
“Appendix C” is [the payment schedule].
[NOTE: List any additional appendices.]
[bookmark: _Toc392005466]LODGING AND OPPORTUNITY FOR PUBLIC COMMENT
[bookmark: _Ref307226245]This Consent Decree shall be lodged with the Court for a period of at least 30 days for public notice and comment. The United States reserves the right to withdraw or withhold its consent if comments regarding the Consent Decree disclose facts or considerations that indicate that this Consent Decree is inappropriate, improper, or inadequate. Settling Defendants consent to entry of this Consent Decree without further notice.
[bookmark: _Ref307226286]If for any reason this Court should decline to approve this Consent Decree in the form presented, this agreement is voidable at the sole discretion of any Party and the terms of the agreement may not be used as evidence in any litigation between the Parties. 
[bookmark: _Toc392005467]SIGNATORIES/SERVICE
Each undersigned representative of a Settling Defendant and the Assistant Attorney General, U.S. Department of Justice, Environment and Natural Resources Division, or his/her designee, certifies that he or she is authorized to enter into the terms and conditions of this Consent Decree and to execute and bind legally such Party to this document.
Each Settling Defendant hereby agrees not to oppose entry of this Consent Decree by this Court or to challenge any provision of this Consent Decree, unless the United States has notified Settling Defendants in writing that it no longer supports entry of the Consent Decree. 
Each Settling Defendant shall identify, on the attached signature page, the name and address of an agent who is authorized to accept service of process by mail on behalf of that Party with respect to all matters arising under or relating to this Consent Decree. Settling Defendants hereby agree to accept service including, but not limited to, service of a summons, in that manner and to waive the formal service requirements set forth in Rule 4 of the Federal Rules of Civil Procedure and any applicable local rules of this Court. The Parties agree that Settling Defendants need not file an answer to the complaint in this action unless or until the Court expressly declines to enter this Consent Decree. 
[bookmark: _Toc392005468]FINAL JUDGMENT
[bookmark: _Ref307226262]Upon entry of this Consent Decree by the Court, this Consent Decree shall constitute the final judgment between the United States and Settling Defendants. The Court [if this Consent Decree is a partial judgment, i.e., it resolves fewer than all the claims alleged in the complaint and/or the liability of fewer than all the parties named in the complaint, insert: finds that there is no just reason for delay and therefore] enters this judgment as a final judgment under Fed. R. Civ. P. 54 and 58. 

SO ORDERED THIS ___ DAY OF _________, 20___.


					___________________________________
					United States District Judge
					

Signature Page for Consent Decree Regarding ______ Superfund Site

					FOR THE UNITED STATES OF AMERICA:


Date: _______________		_______________________________________
					[Name]
					[Assistant Attorney General/Chief/Deputy Chief]
					U.S. Department of Justice 
					Environment and Natural Resources Division
					[Environmental Enforcement Section]
					Washington, D.C. [20530 or 20044-7611]


					_______________________________________
					[Name]
					Trial Attorney
					U.S. Department of Justice 
					Environment and Natural Resources Division 
					Environmental Enforcement Section
					P.O. Box 7611
					Washington, D.C. 20044-7611

[If SFAs, add:]
					_______________________________________
					[Name]
					Trial Attorney
					U.S. Department of Justice 
					Environment and Natural Resources Division 
					Environmental Defense Section
					P.O. Box 7611
					Washington, D.C. 20044-7611

					_______________________________________
					[Name]
					United States Attorney
					District of ______
	[Address]



					_______________________________________
					[Name]
					Assistant United States Attorney
					[Address]


Signature Page for Consent Decree Regarding ______ Superfund Site


					________________________________
					[Name]
					Regional Administrator, Region __
					U.S. Environmental Protection Agency
					[Address]


					________________________________
					[Name]
					Assistant Regional Counsel
					U.S. Environmental Protection Agency
					[Address] 
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Signature Page for Consent Decree Regarding ______ Superfund Site


					
FOR _____________________________________:
						[Print name of Settling Defendant]



Date: __________________		___________________________________________
					[Name and address of Settling Defendant’s signatory]
						

Agent Authorized to Accept Service on Behalf of Above-signed Party:

						Name:		_______________________
						Title:		_______________________
						Address: 	_______________________
						Phone:		_______________________
						email:		_______________________


[NOTE: A separate signature page must be signed by each settlor.]

Instructions Regarding Automated Features

	Feature
	Instructions

	Inserting text copied from a different document
	Text copied from a different document will usually have embedded formatting codes. Pasting the text into your document will cause the formatting codes to be inserted as well, which will create unpredictable and frustrating formatting and numbering results. Therefore, ALWAYS use the “Paste Special” function to insert text copied from another document. Press Ctrl-Alt-V; in the pop-up menu, click “Unformatted Text” and OK. (You can also click the Home tab, Paste, Paste Special, Unformatted Text and OK.)

	Inserting a new paragraph
	Click at the end of the ¶ immediately preceding the place where you wish to add the new paragraph, and press Enter. To change the new ¶'s outline level use (under the Home tab) the styles menu. For example, to change ¶12.b into ¶12.a(1), click in that ¶ and then (using the Home tab) click the "LVL 3" style. To change ¶13.a into ¶14, click in that ¶ and then (using the Home tab) click the  “LVL 1” Style. Note that in consent decree models, the letters denoting each background paragraph must be manually updated.

	Adding an updateable section or paragraph cross-reference
	(a) Click where you wish to insert a cross-reference; (b) Click the “References” tab, and, in the “Captions” box, click “Cross-reference;” (c) In the pop-up menu that appears, make sure the “Reference type” field contains “Numbered item” and the “Insert reference to” field contains “Paragraph Number (full context); (d) In the “For which numbered item” field” select the numbered item (section, paragraph. or subparagraph) you wish to cross-reference, and click Insert.

	Updating the cross-references
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Update Field;” click OK. Note: If a numbered paragraph that has been cross-referenced elsewhere in the document is deleted, remove the obsolete paragraph cross-reference. Otherwise, when you update the cross-references, the following message will appear: “Error! Reference source not found.”

	Updating the table of contents
	Right-click in the TOC, and in the pop-up menu, left-click “Update Field.” Or click in the TOC, press F9, click Update Entire Table and OK. If you have just added a new section heading, click Update entire table before pressing Enter.

	Inserting a new section heading
	Click in the text of the new heading and assign the “SECTION” paragraph style to the text by clicking the “Home” tab, and in Styles box, clicking the “SECTION” style button.) That will add the section number, change the numbering of later sections, and ensure that the new section will be referenced in the table of contents.

	Changing the font
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Font;” in the “font” field, select a new font; click OK.





